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1 Einleitung 
 
Die unüberschaubare Anzahl an verschiedenen Formaten macht die Nutzung von digitalen Audio- und Videodaten 
nicht gerade einfach. Zahlreiche Hersteller setzen auf ihre eigenen Standards und verunmöglichen damit eine 
Kompatibilität unter verschiedenen Betriebssystemen und Trägermedien wie Computer, Internet, Handys, DVD, iPod 
oder Spielkonsolen. Aus diesem Grund kommt man oft nicht drum herum, zusätzliche Software zu installieren, um 
eine Audio- oder Videodatei am gewünschten Ort und für die gewünschten Zwecke nutzen zu können.  
Diese Kurzreferenz gibt Ihnen einige Empfehlungen ab, welche Software Sie wie einsetzen können, um Multimedia-
Dateien problemlos abzuspielen und zu bearbeiten. 
 

2 Software  
 
Die auf den Rechnern vorinstallierten Media Player (Windows Media Player) bzw. (Quick Time Player) können nicht 
automatisch alle Multimediaformate abspielen. Es gibt mehrere Möglichkeiten, diese Einschränkung zu beheben:   
 
1. Sie installieren einen neuen Mediaplayer, der alle gängigen Audio- und Videoformate dekodieren kann. 
2. Sie ergänzen die Multimediaarchitektur Ihres Rechners mit zusätzlichen Filtern (Windows) bzw. zusätzlichen 
Komponenten (Mac). Für Windows eignet sich die Dekodiersoftware namens ffdshow tryouts (http://ffdshow-
tryout.sourceforge.net), der die Windows Komponente DirectShow mit Filtern erweitert und eine Anzahl Audio- und 
Videoformate unterstützt; Mac OSX User können die QuickTime Komponente Perian (http://perian.org) installieren. 
3. Eine weitere Möglichkeit bietet die Installation eines zusätzlichen Codec*  Packs. Diese Lösung ist allerdings nur 
bedingt zu empfehlen, da das Überschreiben alter und das Installieren neuer Codecs* oft mehr Probleme generiert, als 
es löst.  
 
* Als Codec (Kunstwort aus engl. coder und decoder) bezeichnet man ein Verfahren bzw. Programm, das Daten oder Signale digital kodiert und 
dekodiert. Beim direkten Umwandeln von einem Format in ein anderes (bspw. MPEG-2 zu MPEG-4 oder MP3 zu WMA) spricht man auch von 
Transkodierung. (http://de.wikipedia.org/wiki/Codec). 
 

2.1 Media Player 
 

 
 
 
 
 
 
 
 
Name Beschreibung Betriebsysteme Formate 
VLC media player VLC media player ist ein (portabler) 

Media Player, der die meisten Audio- 
und Videodateien abspielen kann. Er kann 
auch DVDs und VCDs, sowie 
verschiedene streaming Protokolle lesen.  

Windows 
Mac OSX 
Linux 
 

MPEG  
AVI  
ASF / WMV / WMA  
MP4 / MOV / 3GP 
OGG / OGM / Annodex 
Matroska (MKV) 
WAV (incuding DTS) 
Raw Audio: DTS, AAC, AC3/A52 
Raw DV 
FLAC 
FLV (Flash) 
MXF 
Nut 
Standard MIDI / SMF 
Creative™ Voice 

 

Mit dem kostenlosen VLC Player können Sie praktisch alle möglichen Multimediadateien 
abspielen. Der Player funktioniert auf Windows und Mac und ist auch in einer portablen 
Version erhältlich. 
 
          http://www.videolan.org/ 
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2.2 Firefox Add-ons 
 

Videos auf dem Internet sind meistens in einen Flash-Player eingebettet und können nicht direkt heruntergeladen 
werden. Es gibt aber Programme, die die Pfade der Videodateien herauslesen und einen Link zum Herunterladen 
anbieten. Die meisten dieser Programme sind Firefox Add-ons*. 
*Add-ons erweitern oder ergänzen eine bestehende Software. Im Gegensatz zu einem Plug-in nutzen Add-ons die vorhandenen Bibliotheken einer 
Software. 
 
 
 
 
 
 
 
 
 

2.3 Linkdetektor Website 
 
Als Alternative zu den Add-ons bieten sich auch Websites an, die aufgrund von URLs Videos ausfindig machen 
können, z.B.:  
 
 
 
 
 
 

2.4 Video- Audio Encoder 
 
Möchten Sie Multimediadateien für ein anderes Zielmedium verwenden - z.B. eine DVD für das Internet, dann 
kommen Sie nicht drum herum, ein Konvertierungsprogramm einzusetzen. 
 
 

 
 
 
 
 
 
Name Beschreibung Betriebsysteme Formate 
SUPER SUPER ist ein kostenloses 

Konvertierungs-Programm für nahezu alle 
Audio- und Videoformate. 

Windows 
 

Video: 3GP/3G2, AMV, ADF, AVI 
(DivX, H263, H263+, H264, XviD, 
MPEG4, MSMPEG4), DAT, FLI, 
FLC, FLV, M2T, MKV, MPG 
(MPEG-I, MPEG-II, VCD, SVCD), 
MOV (H263, H264, MPEG4, SVQ), 
MP4 (H263, H264, MPEG4), NSV, 
OGG, QT, RM, RAM, RMVB, STR, 
SWF, TS (HDTV),M2TS (Blu-
ray),HD TS, VIV, VOB, WMV 
Audio: AAC, AC3, AMR, MP2, 
MP3, MP4, MMF, MPC, OGG, RA, 
WAV, WMA 

Der Fast Video Download und Unplug sind Firefox Add-ons, die  Ihnen helfen, Videos von 
Websites wie YouTube herunterzuladen.  
    
 https://addons.mozilla.org/de/firefox/addon/3590  (Fast Video Downoload)
 https://addons.mozilla.org/de/firefox/addon/2254  (Unplug) 
 
Achtung: Jede Installation eines neuen Add-ons erfordert den Neustart von Firefox! 

 
 

 
 

ClipNabber  oder KEEPVID 
 
 http://clipnabber.com/ 
 http://keepvid.com/ 
 

 
 

 

SUPER nutzt eine grosse Palette an gängigen Codecs zum Konvertieren von Audio- und 
Videodateien. Im Programmfenster lassen sich zahlreiche Einstellungen wie 
Containerformat, Codecs, Bildauflösung, Seitenverhältnis, Bildrate, Audioqualität, Anzahl 
Tonspuren und ähnliches festlegen. Etwas Kenntnisse im Bereich von Audio- und 
Videoformaten sind Voraussetzung, um das Programm zu bedienen.  
 
 http://www.erightsoft.net/SUPER.html#Dnload 
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2.5 Videoeditor 
 

 

 

 

 

 
Name Beschreibung Betriebsysteme Formate 
Avidemux Avidemux ist ein (portabler) Videoeditor, 

der eine Vielzahl von Containerformate 
und Codecs ohne Konvertierung 
bearbeiten kann.  

Windows 
Mac OSX 
Linux 
 
 

Containerformate:  
AVI 
MPEG (als PS oder TS) und VOB-
Dateien (DVD-Video) 
MP4 
OGM 
FLV-Dateien (ab 2.4) 
MKV (ab 2.4) 
ASF/WMV (nur lesen) 
Video:  
MPEG-1, MPEG-2 , MPEG-4  
ASP  
H.264/AVC  
M-JPEG und DV 
HuffYUV 
FFv1 
H.263 
WMV (nur lesen) 
Flash Video (Sorenson-H.263 und 
VP6) 
Audio:  
MP3 AAC  
Ogg Vorbis 
MP2 
AC-3  
PCM und LPCM 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mit dem kostenlosen Programm Avidemux können einfache Bearbeitungsaufgaben ausgeführt 
werden: Kürzen, auftrennen oder zusammenführen von Videos wie auch das Hinzufügen 
einer zusätzlichen Tonspur ist möglich. Zudem stehen zahlreiche Filter zur Verfügung, die 
weitere Manipulationen erlauben: Grösse ändern, Titel einfügen, Farbe bearbeiten etc. Der 
Vorteil von Avidemux ist, dass Videos in den meisten Formaten z.B. auch .flv Dateien direkt 
bearbeitet werden können.  
 
  http://avidemux.berlios.de/download.html 
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3 Übungen 

3.1 Youtube Videos herunterladen  
 

1. Gehen Sie auf die youtube Website und wählen Sie ein Video aus.  
 

Mit dem Firefox Add-on Unplug oder Fast Video Download:  
 

   
 
 
 
Mit der Website Clipnabber oder KEEPVID: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Starten Sie auf youtube die 
gewünschte Videodatei.  

2. Klicken Sie auf eines der beiden 
Symbole  in der Navigations-
leiste.  

3. Die Programme suchen auf der 
Website nach Videodateien und 
zeigen diese in einem separaten 
Fenster an.  

4. Gehen Sie die Liste mit den 
verschiedenen Vorschlägen 
durch und wählen Sie nach 
Möglichkeit die Datei mit der 
besten Qualität aus.  
Wenn Sie die Wahl zwischen 
einer .flv oder .mp4 Datei 
haben, dann wählen Sie nach 
Möglichkeit die .mp4 Datei aus.

5. Speichern Sie die Videodatei auf 
Ihrer Festplatte ab.  

 

1. Kopieren Sie die URL des Films 
aus der Adressleiste Ihres 
Browsers. 

2. Geben Sie die Adresse in das 
Eingabefeld der ClipNabber 
oder KEEPVID  Website und 
klicken Sie auf Nab bzw. 
Download. 

3. Wählen Sie nach Möglichkeit 
das Video mit der besten 
Auflösung und speichern Sie es 
auf Ihrer Festplatte ab. 
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3.2 Internetvideos mit AVIDEMUX bearbeiten 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Öffnen Sie das Programm 
Avidemux und ziehen Sie das 
heruntergeladene Video auf die 
graue Arbeitsfläche. Sie können 
weitere Videos auf die 
Arbeitsfläche ziehen. Diese 
werden dann einfach am Schluss 
angehängt. Bedingung ist  aber, 
dass die Videos das gleiche 
Format und die gleiche Grösse 
haben.  

2. Gehen Sie an den Anfang der 
Stelle, die Sie herausschneiden 
möchten und klicken Sie auf das 
Symbol mit dem Buchstaben A. 

3. Gehen Sie ans Ende der Stelle, 
die Sie herausschneiden 
möchten und klicken Sie auf das 
Symbol mit dem Buchstaben B. 

4. Ein blaues Rechteck sollte nun 
Anfang und Ende markieren.  

5. Unter Edit finden Sie nun die 
Funktionen, die zur Verfügung 
stehen:  
Cut = Die selektionierte Stelle 
wird weggeschnitten. 
Copy = Die selektionierte Stelle 
wird kopiert. 
Paste = Wenn Sie vorher eine 
Stelle kopiert haben, wird diese 
an der Stelle des Cursors 
eingefügt. 
Delete = Die selektionierte 
Stelle wird gelöscht. 

 Film abspielen 
 Film stoppen 
 Gehe zum vorhergehenden Frame  
 Gehe zum nächsten Frame 
 Gehe zum vorhergehenden Keyframe 
 Gehe zum nächsten Keyframe 
 Gehe zum vorhergehenden schwarzen Frame  
 Gehe zum nächsten schwarzen Frame 
 Gehe zum Anfang des Films 
 Gehe zum Ende des Films 

  
 Anfang der Auswahl setzen 
 Ende der Auswahl setzen 
 Cursor - markiert den aktuellen Frame 

 

HINWEIS: Die Anfangs - und Endpunkte sollten bei einem Keyframe 
liegen, da sonst der Schnitt nicht sauber ausgeführt wird. Keyframes 
sind uncodiert und dienen als Referenzpunkte für die nachfolgenden 
Inter Frames. 
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AVIDEMUX Filter hinzufügen - Video exportieren 

In Avidemux finden Sie unter dem 
Menupunkt Audio zahlreiche Filter, 
mit denen Sie das Bild manipulieren 
können.   
 
Um einen Filter anzuwenden, öffnen 
Sie den Video Filter Manager. Sie 
sehen dann eine Liste mit Filtern, die 
Sie auswählen können. Um einen 
Filter zu aktivieren, ziehen Sie ihn 
einfach in das rechte Feld.    
 
Falls ein Filter nicht für die ganze 
Länge des Videos angewendet 
werden soll, dann können Sie einen 
Start- und Endpunkt setzen: Klicken 
Sie auf Partial und geben Sie die 
Framezahl des Anfangs- und 
Endpunktes an.  
 

Videofilter 
Transform -> Crop  
Störende Ränder können weg- 
geschnitten werden. 
 
Transform -> MPlayer resize  
Grössenanpassung  
 
Transform -> Add black borders 
Hinzufügen von schwarzen 
Rändern, z.B. nützlich bei 
Formatanpassungen von 3:4 nach 
16:9 oder umgekehrt. 
 
Transform -> Fade 
Nach Schwarz ein- ausblenden. 
 
 

Colors -> MPlayer eq2/hue 
Kontrast und Farbanpassung 
 
 Colors -> Luma only 
Umwandlung Farbe zu 
Schwarzweiss 
 
Sharpnes -> ... 
Diverse Filter, um das Bild zu 
schärfen.  
 
Miscellaneous -> Logo 
PNG Bilder können importiert 
werden, z.B. für Titel, 
Kommentare, Markierungen, 
Logos.

Um die Wirksamkeit eines Filters 
auszutesten, können Sie 
verschiedene Ansichten wählen: 
Klicken Sie auf eines der 5 
Anzeigesymbole in der Menuleiste. 
 
Das bearbeitete Video können Sie 
wie folgt exportieren: File -> Save -
> Save Video. 

HINWEIS: Damit beim Exportieren ein Filter wirksam wird, 
muss bei Video ein Codec ausgewählt sein!  



  

 

        
Video Aufbereitung 2.1 - April 10 Seite 8

© Fachstelle Neue Lernmedien 
 

 

3.3 DVD Filmmaterial in eine Powerpointpräsentation einbinden 
 
 
Sie möchten den Inhalt einer ungeschützten DVD in einer Powerpointpräsentation einbinden und von dort aus direkt 
abspielen.  
 
 

 
Arbeitsschritte:  
1. Kopieren Sie die Inhalte einer DVD auf Ihre Festplatte. Die Inhalte dürfen allerdings nicht geschützt sein, was 

bei den meisten kommerziellen DVDs* der Fall ist.  
2. Öffnen Sie das Konvertierungsprogramm SUPER.  
3. Suchen Sie im Video_TS Ordner die grösste Datei und ziehen Sie die .VOB Datei in das Programm.  
 
* Geschützte Dateien müssen Sie zuerst mit einer Entschlüsselungssoftware rippen. Dieser Vorgang ist in der Schweiz legal, sofern der Inhalt 
der DVD zu privaten Zwecken genutzt wird. Auch der Erwerb und der Gebrauch von Entschlüsselungssoftware ist erlaubt, jedoch nicht dessen 
Herstellung, Verkauf und Vertrieb.  
 
 
 

Ausgangsmaterial 
DVD mit Video_TS Ordner und 
VOB-Dateien  

Endmaterial  
Powerpoint kann im Moment nur zwei 
Videoformate direkt einbinden:  
 WMV 
 AVI

Konvertierungsprogramm 

4. Selektionieren Sie den Output 
Container. In unserem Fall ist es das 
Format: wmv. 

5. Selektionieren Sie den Output Video 
Codec. Wählen Sie hierfür WMV9. 

6. Selektionieren Sie den Output Audio 
Codec. Wählen Sie hier wma3. 

7. Legen Sie die Grösse des Videos fest. 
Die Normalauflösung für DVD ist 
720x576. Diese Auflösung kann für 
eine Offline Version beibehalten 
werden. Klicken Sie in diesem Fall 
unter Video Scale Size auf NoChange. 
Ansonsten wählen Sie eine Grösse, die 
dem Verhältnis Ihres Ursprungsvideos 
entspricht, z.B 480x272 wenn das 
Material in 16:9 Format gedreht wurde. 

8. Wählen Sie 25 Frame/Sec für die 
Anzahl Frames, die pro Sekunde 
abgespielt werden sollen.  

9. Die Bitrate (kbps) kann hoch sein, da 
der Film offline abgespielt wird. 
Wählen Sie 3600 kbps oder höher. 

10. Für die Audio Sampling Frequence 
können Sie 48000 wählen, dies 
entspricht der Samplingfrequenz auf 
der DVD.  

11. Wählen Sie 2 Channels und eine 
Bitrate von 128 kbps.  

12. Klicken Sie am Schluss auf Encode. 

Die umgewandelten Dateien finde Sie im Ordner:  
E:\PortableApps\SUPER\super\OutPut 
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3.4 Video in Powerpoint einbinden 
 
 
 
 
 
 

1. Öffnen Sie Powerpoint und 
erstellen Sie eine neue 
Inhaltsseite.  

2. Wählen Sie im Menu 
Einfügen -> Film und Sound   
-> Film aus Datei ... 

3. Wählen Sie die gewünschte 
.wmv oder .avi Datei.  

4. Passen Sie falls nötig die 
Grösse des Films an.  

5. Testen Sie den Film im 
Präsentationsmodus  

Falls eine .avi Datei nicht 
abgespielt werden kann, dann 
liegt das Problem meistens an 
einem falschen Codec. In 
diesem Fall sollten Sie die 
Datei umcodieren. 
Verwenden Sie entweder 
einen anderen .avi Codec oder 
wählen Sie direkt einen .wmv 
Container.  
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4 Podcasts mit iTunes verwalten 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

«Podcasting bezeichnet das 
Produzieren und Anbieten von 
abonnierbaren Mediendateien 
(Audio oder Video) über das 
Internet. Ein einzelner Podcast ist 
somit eine Serie von 
Medienbeiträgen (Episoden), die 
über einen Feed (meistens RSS) 
automatisch bezogen werden 
können.» 
Wikipedia 

Podcast können mittels eines RSS 
Feed abonniert werden. Ein Feed 
versorgt den Adressaten, ähnlich 
einem Nachrichtenticker, mit kurzen 
Informationsblöcken, die aus einer 
Schlagzeile mit einem kurzen 
Textanriss und einem Link zur 
Originalseite bestehen.  
 
RSS Feeds können in einem 
Browser oder in einem speziellen 
Programm wie iTunes abonniert und 
verwaltet werden.  

TV-Stationen verunmöglichen oft 
das Herunterladen von Videos. 
Manchmal bieten diese aber 
Sendungen als Podcasts* an.  

Podcast RSS-Feed

Um einen Podcast in iTunes zu 
abonnieren, gehen Sie wie folgt vor:
 
1. Rufen Sie die Website auf, von 

der Sie eine Sendung 
herunterladen möchten.   

2. Suchen Sie auf der Seite nach 
dem Podcast oder RSS-Symbol. 
Oder geben Sie im Suchfeld der 
Website den Begriff "Podcast" 
ein.  

3. Falls es einen direkten Podcast 
Link zu iTunes gibt, klicken Sie 
diesen an. Sie werden dann in 
den iTunes Store umgeleitet, wo 
Ihnen die Möglichkeit gegeben 
wird, den Podcast zu 
abonnieren.  
 
Ansonsten kopieren Sie die RSS 
Podcast Adresse: Rechte 
Maustaste -> Link-Adresse 
kopieren 

4. Öffnen Sie iTunes. 
5. Gehen Sie auf den Menupunkt 

"Erweitert" und wählen Sie 
Podcast abonnieren.  

6. Fügen Sie die kopierte URL in 
das Eingabefeld ein.  

Achtung: nicht alle Podcasts sind 
kostenlos.  
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5 Videos auf ILIAS hochladen und als Mediacast publizieren 
 
Mit der Mediacast-Funktion können Sie Multimediadateien direkt auf ILIAS publizieren und abspielen. Ein 
Mediacast kann mittels RSS-Feed abonniert werden. Dafür benötigen Sie allerdings einen RSS-Reader.  
Safari, Firefox und Internet Explorer 7 haben einen RSS-Reader eingebaut. Es ist auch möglich, den Mediacast in 
iTunes oder einem anderen vergleichbaren Programm zu abonnieren. 
 
Der ILIAS Mediacast unterstützt folgende Dateiformate: 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Neuen Mediacast anlegen 
1. Wählen Sie im Auswahlmenu 

oben rechts Mediacast. 
2. Geben Sie dem Mediacast einen 

Namen und ev. eine kurze 
Beschreibung. Speichern Sie 
den Mediencast. 

3. Um ein Video hinzuzufügen, 
klicken Sie auf «Hinzufügen». 
Füllen Sie die Felder für Titel 
und Beschreibung aus.  

4. Bestimmen Sie die Zugriffsart 
auf das Video. Wählen Sie 
«Öffentlich», wenn auch 
Benutzer ausserhalb von ILIAS 
auf die Dateien zugreifen 
dürfen, ansonsten «Eingeloggte 
Benutzer». 

Mediacast in iTunes abonnieren 
1. Kopieren Sie den RSS-Feed 

Link des entsprechenden 
Mediacasts. (RSS-Feed Icon 
anwählen und die rechte 
Maustaste drücken, «Link-
Adresse kopieren» auswählen. 

2. Öffnen Sie iTunes und wählen 
Sie unter dem  Menupunkt 
«Erweitert»  «Podcast 
abonnieren».  

3. Fügen Sie den kopierten Link in 
das Feld ein und klicken Sie  auf 
«OK». 

4. Der Mediacast sollte nun auf der 
Liste erscheinen und kann 
verwaltet werden. 

Audio 
.mp3  MPEG Layer 3 Audio 
.m4a MPEG-4 Audio 
.aac  Advanced Audio Coding 
  

 Video 
.mov  Quicktime 
.mp4  MPEG-4 
.mpg  MPEG-1, MPEG-2 Movie 
.mpeg MPEG-1, MPEG-2 Movie

Multimedia 
.swf  Shockwave Flash 

RSS-Feed des Mediacast 
abonnieren 
1. Klären Sie ab, ob Ihr Browser 

einen RSS-Reader eingebaut 
hat. 

2. Falls dies der Fall ist, klicken 
Sie einfach auf das RSS-Icon 

 . Sie sollten nun den Feed 
als Bookmark in Ihrem 
Browserfenster einfügen 
können.  
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6 Codec versus Container 
 
Ein Container (englisch für „Behälter“) ist ein Format, das verschiedene Datenströme mit Hilfe eines Multiplexers 
(Muxer) in einer einzigen Datei vereint. Ein typisches Beispiel sind Videocontainer, die Bild- und Tonspuren in einer 
Datei aufbewahren. In diesem Fall kann die Datei ein .avi Container sein, die eine mp3 Audiospur und eine MPEG-4 
Videospur enthält. In einem Video Object Container der für DVDs verwendet wird, finden sich zudem noch Dateien 
für Menu, Untertitel und weitere Sprachen. Container definieren nur die Art und Struktur, wie die verschiedenen 
Datenströme verpackt werden. Ein Container kann Daten mit verschiedenen Codecs enthalten.  
Ein Codec definiert das Verfahren wie eine Datei oder ein Signal kodiert und dekodiert wird.  
Welche Audio- und Videocodecs man typischerweise in den jeweiligen Containern findet, fasst die folgende Tabelle 
zusammen:  
 
Container Name Einsatz für Videocodecs Audiocodecs 

AVI Audio Video Interleave Powerpoint  MPEG-4, DV, MJPEG, 
Indeo, Cinepak 

MP3, MP2, (AD)PCM, 
AC3 

DIVX DivX Media Format  DivX MP3, AC3, PCM 

DV Digital Video Camcorder DV PCM 

FLV Flashvideo ILIAS, youtube H.263, VP6, H.264 MP3, AAC, ADPCM 

MKV Matroska  H.264, MPEG-4 MP3, AC3 

MP4, M4V MPEG-4 ILIAS, iTunes, iPod, 
iPhone, youtube, 
Spielkonsolen 

MPEG-4, H.264 AAC 

MPG MPEG Program Stream  MPEG-1, MPEG-2 MP2 

MOV QuickTime Movie ILIAS, iTunes  H.264, MPEG-4, MPEG-1, 
MJPEG, Sorenson Video 

MP3, AC3, PCM 

OGM Ogg Media  Ogg Theora, Xvid Ogg Vorbis, MP3, AC3 

RM(VB) Real Media (variable Bitrate) Streaming Real Video Real Audio, AAC 

TS/TP/TRP/ 
PVR/VDR 

MPEG-2 Transport Stream (188 
Byte) 

DVD MPEG-2, H.264 MP2, AC3 

VOB Video Object DVD MPEG-2 AC3, DTS, PCM, MP2 

WMV Windows Media Video Powerpoint Windows Media Video, VC-1 Windows Media Audio 

 
 
 
 
 
 

Co
py

rig
ht 

20
09

/10
 ©

 H
oc

hs
ch

ule
 Lu

ze
rn

. T
his

 do
cu

me
nt 

is 
lic

en
se

d u
nd

er
 

a C
re

ati
ve

 C
om

mo
ns

 A
ttr

ibu
tio

n-
Sh

ar
eA

lik
e 2

.5 
lic

en
se

. 


